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Seismology Instruction with the AS-1

Introduction

The AS-1 System was designed and built to make the science of seismology accessible to
individuals and schools at a reasonable cost. With the AS-1 seismometer, you will be able to
record and analyze earthquakes. In the classroom, the instrument will allow students to watch
a quake roll in as it is occurring. Students will be able to watch a current event unfold, long
before the media reports begin.

The AS-1 seismometer combined with the AmaSeis software allows real-time recording
of seismic events and simpé8 data analysis. The AmaSeis software automatically stores the
ground movements so that the earthquake can be extracted and analyzed at a later time. The
AS-1 System will record local quakes as small as magnitude 3.5 at a distance of 150 km, and
larger quakes that occur anywhere in the world.

This manual will take you through the setup, software installation, and use of your AS-1
System. It will also give you an introduction to seismogram interpretation and analysis.

Seismometer Location

There are two important location considerations:

Seismometer

» Find a suitable location for the seismometer, preferably where local vibrations from
people or machinery are at a minimum. Vibrations can be caused by air conditioning
units, traffc, construction, or weather. The vibrations, called seismic noise, can

hide seismic signals from smaller events. The best surface for the seismometer is

a concrete or stoneofbr, in a location free of extreme temperature variations. A

back room or storage closet out of the way is an ideal location for the instrument

for optimal recordings. The seismometer can be out on display in a public place so
that students can see it in operation, but the tradeoff is that fewer earthquakes may be
detected because of increased local vibration.

Computer Display

* The computer display showing the real-time data does not need to be close to the
seismometer. The AS-1 is shipped with a 7 m (22 ft) paired shielded coaxial cable.

The cable can be extended, allowing freedom of placement. We have purchased 21.5 m
(70 ft), without loss of signal. ldeally, place the computer display in a prominent

location either a classroom or public area where data can be monitored.
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Seismology Instruction with the AS-1

Seismology Overview

Earthquakes are caused by the sudden movement of blocks of the Earth’s crust. Such
movement involves the fracture of brittle rocks and the movement of rock along the fractures.
A fracture in a rock along which movement occurs is called a fault.

When an earthquake occurs, it releases energy in the form of waves that radiate from the
earthquake source in all directions. The different types of energy waves shake the ground in
different ways and also travel through the earth at different velocities.

» The fastest waves, and therefore that fo arrive = i
at a given location, afe waves(Primary waves) or ZZ7 77777777/ /i
compressional waves. Like sound waves, they ﬁ

by alternately compressing and expanding mater E———
in the direction of motion. ==

I

» The next signifiant waves to arrive are tBe
waves (Secondary waves). They travel through
the earth moving material up and down and side
to side perpendicular to the direction on motion. 1/

5 Wave

* The last to arrive arfgurface waveswhich
travel slower than P and S waves and move the
ground like a rolling ocean wayRayleigh) or side
to side like a S wav@.ove).

L Wi
Rayleigh Wave ove Wave

]

i WANNNSENAURRENEARRARANREE] i

The distinction between types of wave motions is important because it determines what will
be recorded on a seismometer. The AS-1 is a vertical component seismometer, which means
that it records waves that displace the ground in a vertical direction only. Thus, we can expect
to record P, S, and Rayleigh waves. Since Love waves move horizontally we will not be able
to record them on this seismometer.

What can you expect to see in the AS-1 recording? Often the quality of the record will
allow you to pick out each of the waves, but other times there may be noise on the seismogram
that makes it difftult to distinguish the arrivals. See fhips for Picking P, S, and Surface
Wavessection for examples of picking wave arrivals.
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Seismology Instruction with the AS-1

Packing List

The seismometer should arrive partially assembled.

Boom arm
Base with support post and attached spring and pickup coll
Damping fliid container

Interface box with 9-pin signal cable
Paired shielded coaxial cable
Power supply box

1 % inch diameter washers

Bubble level

P ORRPRRERRRRE

Base

Damping Fluid Container
Washers
Bubble Level

Paired shielded coaxial cable

Boom Arm

Power Supply Box

Seismometer Assembly Interface Box

1. Unpack the box completely and identify the parts from the packing list.

© University of Arizona



Seismology Instruction with the AS-1

2. Place the base of the seismometer on a e
level surface. The base contains three levelirlg \

screws (Figure 1). Use the bubble level and
adjust the leveling screws as needed. Check
the level of the base both front-to-back and
side-to-side. . \
Figure 1

3. Remove the tape from the knife-edge at the end of
the boom.CAUTION: The knife-edge is sharp, be
careful not to cut your hand or damage the knife-e
One end of the spring should be already connected
to the upright support post. Attach the other end of
the spring to the boom. Position the boom’s knife
edge into the slot on the support post. The boom wil
be positioned at an angle, this is to be expected and |
will not damage the boom (Figure ZLAUTION: |
Before moving the seismometer, disconnect the boom _

to prevent damage to the knife edge. Figure 2

4. The upright bolt on the boom arm requires a stackvefliashers
approximately 2.5 cm (1 inch) from the top. Secure the stack
between hex nuts (Figure 3)

With the added weight of the washer stack the boom arm should
now be suspended over the coil. Center the magnet over the coil
(Figure 4) by sliding the knife edge at the support post (Figure 5).
The boom arm should move freely up and down, but the magnet
should not touch the coil.

Figure 3

5. Carefully swing the boom up until
it is possible to position the damping
fluid container under the damping

vane. Do not fi the container before
it is positioned correctly.

CAUTION: Do not release the boo
arm abruptly and allow the magnet
to hit the coil. The equipment is

sensitive, handle and adjust the parts
carefully and gently. Figure 5

6. Add fluid to the dampingdiid container with either mineral oil or synthetic 10-40 motor oil.
The fluid level should be 1 cm (3/8 inch) below the top of the container.

© University of Arizona



Seismology Instruction with the AS-1

7. The boom arm must be level to accurately
record vertical motion. Begin by positioning t
bubble level on the boom, as shown in Figure €
If needed, add one or two washer(s) along the
boom until the boom is level. The positioning
the washers and the bubble level will vary. TH
bubble level and the balance washer(s) stay ¢
the boom arm to keep it level.

8. Rotate the bubble level 90 degrees on the
boom. Adjust the base leveling screws until the
bubble is again centered. Rotate the bubble level
90 degrees back to its starting position.

9. Check that the magnet is still centered above the coil.
boom can be horizontally adjusted by pushing the boom ¢
the support post (Figure 7). The boom arm should move
freely up and down, but the magnet should not touch the
colil.

10. Attach the paired shielded coaxial cable to the interfag
box. To attach a wire to a post the wire must pass throug——
the hole on the post (Figure 8), then tighten the plastic knob.
The center conductor of the signal cable (uninsulated wi
should be connected to the ground terminal (black post)
the interface box. The remaining two insulated wires sh
be connected to the two red posts. (Figure 9)

Figure 7

11.There are 2 cables Ieavin -
the interface box (Figure 10)
The paired shielded coaxial
cable (attached to the interfa
box in Step 10) has a red pl
connector on the end. The @
other cable has a gray 9-pin §
connector. Install the 9-pin
connector from the interface
box to the serial port on your
personal computer. If your
serial card has a 25-pin con-
nector, you will need to pur-
chase a 9- to 25- pin adapter
(available at Radio Shack).

Figure 8

Figure 9

Figure 10
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Seismology Instruction with the AS-1

12. The paired shielded coaxial cable attached to the interface box has a red connector end.
Plug it into the matching red connector on the seismometer base.

13. Plug in the 5-pin cable from the power supply box to the 5-pin slot on the interface box.
Plug in the power cord from the power supply to an outlet (Figure 10).

Figure 10

14. Cover the seismometer with the plexiglass display box. This will minimize motion of
the boom due to air currents.
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Seismology Instruction with the AS-1

Software Installation
a) Installing from CD
« Exit all windows programs before inserting the CD.
* Insert the disk in your CD drive. The setup program will automatically be launched.
* Install using the default settings
b) Downloading AmaSeis
e Go to: http://www.geol.binghamton.edu/faculty/jones/asl.html
 Click on the link labeledmaSeisSetup.exe
» Save the e to theDesktop

» Double click on theamaseissetup.exen the desktop. This will launch the setup
program

The standard installation will putds inMy Computer > System C > AmaSeis

It will also put an icon under the Start meStart > Programs > Seismology > AmasSeis

Installing a New Version of AmaSeis

Fis ES Vew Fooses Took Hep

Once AmasSeis is installed you will need to check for | === 555 e ew se om0

Bekbyen [ ] e i g bt by ot 2] @oe [

program updates every few months. 3

AmaSeis: An IRIS program to acquire
seismometer data

To upgrade your version go to: |
http://www.geol.binghamton.edu/faculty/jones/as1.htn}

 Click on the link labeledmaSeisUpgrade.exe

If prompted save thelé to theDesktop

» Double clickon theamaseisupgrade.exéle on the desktop

This will open theWinZip Self Extracting Dialog Box oo et e -
specified folder press the Unzip buttan, -——I
 Click onUnZip to upgrade AmaSeis i _Punviizp |
p pg w:."-.-'il.rr-a'EiE-i-;- Brawse I
f\’ YEPANITE Hles WITNOUC promplir:
« If your computer does not have the e e et |
WinZip software, a copy is included on the IS
AmaSeIS CD Gfilefs) unzipped successhully

Once the extraction is complete a message box will appear saying the upgrade was
successful. The AmaSeisUpgrade.eledan be deleted from the desktop.
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Seismology Instruction with the AS-1

AmaSeis File Structure

AmasSeis stores data in a set of nested folders. A year’s worth of data will take up about
500 megabytes. This can be searched for events at any time. Be aware of the amount of space
the data will take so that you don'l frour disk. To erase old data, use the Windows Explorer.
Remember, once it is deleted, you can not recover it.

The path to the AmaSeis directory (if you used a standard instdly) @omputer >

System C > AmaSeisThe AmaSeis directory contaidata folders, fes, and the program.

* AmasSeis creates a series of nested folders | « -~ o aws cr -
to store data. The top level folders are divided__13
by years. In each year folder, there will be 12|
month folders which contain subfolders for
each day. The actual datee$ are saved with
the naming convention hour.z.

Addrers [ 1 E \ienaien

*®

* AmasSeis references time in Coordinated » S
Universal Time (UTC), the international time m.,.;m..‘" -
standard. It is the current term for what was -

commonly referred to as Greenwich Meridian R
Time (G MT) Zero (0) hours UTC is mldnlght | Fle Edi WView Favorites Tacks: Heln
in Greenwich England, which lies on the zero | Bk - 9 - ()| Qoeach ThFolers (g
longitudinal meridian. Universal time is based R oo
on a 24 hour clock, therefore, afternoon hours L
su_ch as 4 pm UTC are expressed as 16:00 UTC T
(sixteen hours, zero minutes). @ | address [ 2001
. 12_06_125 !ETIE I I SiZE'I_T_
Conversions of UTC: __ B —
Mountain Standard (Tucson) + 7 hours | ek~ = - | A=
Eastern Standard (Washington DC) + 5 hours e | address |1 11
Mame ~ !
14
CAUTION: Keep your computer set to local == Qs
. . . 118
time, AmaSeis makes the necessary adjustment D || ek - > |
based on your time zone setting. =l - EE
20
[z
Cler
Clzs
29
[kt
22 objects)
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Seismology Instruction with the AS-1

Setting the Date and Time

Set the date and time on your computer before you launch AmaSeis. The software will
record data based on these settings, and it is crucial that the time is as accurate as possible.

» SelectStart Menu > Settings > Date/Time

Time is available from:

* http://www.time.gov

10 11 12 13 14 15 16

17 18 18 20 21 22 23

or you can also download a program to automate time updates | |5 =% 5
over the internet (set to update hourly) from

115300 =

Current time zone:; LS Mounkain Standard Time:

* http://www.boulder.nist.gov/timefreq/service/its.htm [ | o

CAUTION: Itis highly recommended that the time setting

be checked on a monthly basis. Some systems lose accuracy
as time passes, and even a discrepancy of a minute or two
makes it very dificult to identify events.

Launching the Program

asl.exe

* To launch the software Double Click on the program i

e The software assumes the AS-1 seismometer is attache (k&

the communication port COM 1. If you receive a ‘no data’ | Hedsta=

Setting zampling rate to & per second

error message, your computer is not receiving data from the
seismometer. This will occur if the AS-1 is attached to a

different port. To # this error change the port setting.

Changing the Port Setting

» SelectMy Computer > System C > AmaSeis
Double clickon AS1.INI

Edit the COM=1 line to match the computer settir|::
Choosd-ile > Saveto save the changes

Quit and relauncAmasSeis o

NOTE: If more than one version &imaSeisis open an error will appesmmmm =

Make sure to close all open programs, then launch the software
by double clicking on the program icon.

This is a trial and error process. Experiment with different COM ports (1-4).

Problem opering COML

© University of Arizona
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Seismology Instruction with the AS-1

Launching the Program

* To launch the software double click on the program [E=
asl.exe

* An introductory screen will display for approximately 5 seconds. After that time,

the helicorder screen will appear. On thstfiaunch of the software, the station

parameters need to be set.

Setting Station Parameters

* From the Menu Bar chooSettings > Station

 Edit the station properties =

Station M ame [k

- Station Name

tatioh M arme|

1
4

- Latltu_de Latitude [N postive] P Cancel |
- Longitude g [sunve
- Elevation Largityde [E positive] Erene M
- Station Code £ - vened

This is aSSigned to Elesvatior [rn]  Notth M

the instrument by the [0 C Esstfe]

network administrator

contact: braile@purdue.edu
- Component

The AS-1 is a vertical

component instrument

» To determine the latitude and longitude of your school consult a topographic map or
online at http://terraserver.nomeadvisor.msn.com

» Once the station properties have been entered, this information is stored and does

not need to be entered again. =
Lires per hour Days to retain records
o . in
Flnd|ng The Trace Gair Decimate factor ﬂi
ln_ I‘\_ Help
» From the Menu Bar choose Settings > Helicorder | toupss it custi !
-
e Set the Gain to 25

e The trace will now be drawn on the screen,
and it may be visible. Or, more commonly, \
it is recording off the screen. Slowly move

the potentiometer (black knob) on the AS-1
interface box until the trace is visible
approximately at the center of the screen.

© University of Arizona 12



Seismology Instruction with the AS-1

Centering the Trace

The trace is the actual recording of the seismometer. Each line on the screen represents
one hour, so the trace moves slowly. The trace for the current hour should be displayed on
the bottom line on the screen. Sometimes the trace is not centered on its hour line. To
center the trace:

* From the File Menu choose Settings > Set Zero Level 2

« To shift the trace down to the correct hour line incredse ™

the value in the Set Zero Level pop-up window. Large| [ o | Cancel |
jumps to the bottom of the screen require shifts in the
100s; fne-tuning of the trace positions requires shifts of
less than 20.

Instrument Settings
* From the File Menu choose Settings > Helicorder

* Lines Per Hour The display can show anywhere
between 1 and 24 hours of data on the screen. This
value defaults to 1, which means that the width of tf
screen represents one hour. The data for one day is
contained on one screen, this can be useful in searching

If you change the lines per hour setting to 3, one hour of recording will take
up three lines and 8 hours of recording will be seen on one screen rather than 24
hours. The value can be increased up to 60 to show details of the waveforms. This can
be useful for in-class testing and demonstrations.

Low pass filter cutalf [Hz)

—

« Gain This setting adjusts the ampdidition of the signal and varies with the location
of the seismometer. Choose a gain setting such that the background noise is just
visible. For example, there is always a little bit of up and down movement of the
trace. A values between 25-50 is suggested. If the trace is too noisy, adjust the gain
to a lower value.

* Low pass flter cutoff Set to 3 Hz.

» Days to retain records This setting controls how many days are available to scroll
back through when looking for events. All data will be stored by the system until it is
deleted by the user, this setting just controls how much is available to display.

» Decimate Factor This setting controls the number of plotted points when the trace
is redrawn, but it does not affect the quality of the recording. Leave this setting at
the default setting of 1.

© University of Arizona 13



Seismology Instruction with the AS-1

Congratulations!

By reaching this point, your seismometer is accurately recording and will store any
events that it is able to detect. The AmaSeis program needs to be running at all times in
order to collect data, however the display window can be minimized and the program will
still record.

Helicorder Screen Overview

The window that appears when the program is launched is
called the helicorder screen. The recording emulates what ap
on a drum recorder.

» Using default settings each horizontal line represents
hour. The current time (UTC) is found in the bottom left
corner of the screen. The trace should be recording alg
the bottom hour line.

* The date is posted on the 00 hour line. The scroll bar along the right side of the
window can be used to scroll back through the earlier recorded data.

» The sampling rate is shown near the top left of the screen and is the data per second
that are sent from the seismometer to the computer. It should be a number between 6.1
and 6.2 samples per second for the AS-1. This rate is determined when the introduction
screen is visible, by counting the number of data points that arrive in 5 seconds.

asi <l Menu Bar w—

Fig Settngs Control  Hely

M.n.m.n..\
N Scroll Bar
Sampling Rate \\
g A
X

Hours (y-axis)
]

Date

220822,

Current Time (UTC) Minutes (x-axis)
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Seismology Instruction with the AS-1

Saving an Event

* From the helicorder screéighlight an event by holding
down the left mouse button and scrolling over the event :*ME

 Click the extract icon below the Menu B4~

This will open theExtract Event Screen
» To save the data in afiselecFile > Save As
* In the upper left corner of ti&ave As Dialog Boxhame the fe (change the * in

front of .sac to your fename). Please use the following naming convention:
two digit year, two digit month, two digit day, two digit hour, station code

(yymmddhhstcode) Save ht
File name: Folders:
Fm— ehamaseis

Example: Tempe High School (thaz)
recorded an event at 19:30 on June 23, 2001
01062319thaz.sac

:—I =y ;j Cancel I

= AMASEIS
£ 2001
£ 2002

=
* In the bottom left hand corner, set
theFile Type to SAC

Drives:

I e GISDatal - Metwark.. |

» Send us your event!You can upload the SAQdithrough your internet browser at
http://www.geo.arizona.edu/geoed/spinet

Printing an Event
* From the Extract Event screen click on the print ibj

or from the Menu Bar choo$éle > Print

rint HE

MNarme:

Status:  Ready
Tope:  HP Laseret 4050 Series PS

Where:  hp§17

Comrent: T~ Print to fle

* At the Print Dialog Box click oRroperties

» Set the Orientation toandscape,Click OK

Print rang

= Al

¢ Click theOK button ot ]|

© University of Arizona 15



Seismology Instruction with the AS-1

Extract Event Screen Overview

The highlighted portion of the trace is displayed in this window.

451 - [untitled]

» Time Expansion expands the x axior example, when the time expansion is 2,
the time axis is doubled in length allowing you to zoom in. In this case onlyghe fi
half of the waveform is displayed. To see more of the waveform use the scroll bar
at the bottom of the screen.

» Load a previously saved event using®pen Icon

* ThePick Arrivals Icon is used to mark wave arrivals. F0r|_hg_

regional events it is sometimes easier to mark the P wave
Surface wave arrivals. For global events, mark the P and S wave arrivals.

¢ TheTravel Time Curves Iconis used to determine the distance from the event to
your station using the time delay between wave arri\I _ E

e 5 N
8 el

[&] File Settings Cortral Help =18

BBy " @I

Open

SUNYB 2
B Return to 2001/06/23 20:41:00

Helicof'der Sample rate: 6. Npts: 83489
Screen

Event Information

Amplitude (y-axis)

I

77 TN N N[ S S S N [ S S S N M S S S S NS Y [ NN [ S|

0 20 <l Ll i 100 120 i 161} B0 200 i)
_E Hime Expansion MINUES

Minutes (x-axis)

Time Expansion

© University of Arizona
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Seismology Instruction with the AS-1

Tips for Picking P, S, and Surface Waves

* TheP waveis the frst arrival

P Wave

« TheS waveis generally the next large arrival \

« If the event is large, distant, and not too
deep you will recor&urface waves

S Wave

\

-

Surface Wave

P Wave

Picking Arrivals in AmaSeis

* OntheExtract Event Screenclick on thePick Arrivals Icon .

\
Vi

\
1

S Wave

» Mark the arrival by positioniN Qe

the mouse on the trace at the
arrival and clicking with théeft
Mouse Button

« For regional events, mark the
P wave and Rayleigh wave
arrivals. For global events,
mark the P and S wave arrivals

¢ Picks will be marked with a
vertical brown line. To repick,
click on thePick Arrival Icon.

i

T Caqtmstom

© University of Arizona
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Seismology Instruction with the AS-1

Using the Travel Time Curve

* After picking arrivals in th&xtract Event Screenclick
on theTravel Time Curve Icon | E %

» Using the Mouse, drag the trace up or down along the vertical axis to align the
Arrival Picks with the correspondinBhase Arrival Lines.

* Once the record is aligned with the travel time curve, the distance to the event is reported
on the left under the trace.

» The distance is reported in degrees. To convert from degrees to kilometers:
1 degree = 111 kilometers

Love Surfage ¥ avgs

P’ P
\ / Rayleigh Surface Waves

Phase Arrivals

-
=

=
=

Distance

L)
ar
o
=
=)
ar
7]
=
o
%)
=
]
=
)
D
<)
=
]
ar
o
=
L)
o
o
i
Ly

mu'.-"'nﬂmm.u_l‘i., ‘lu”MlllJm.lu|..h||||n.|l.1ll

Miites
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Seismology Instruction with the AS-1

Storing Event Information

Once you have identfd an event that your AS-1 has recorded, you can store information
about it for future instructional use. There are many applications for using real-time seismic
data in the classroom.

To store data about an event:

« On theExtract Event ScreenselectSettings > Event

» Enter the event information ]
in theEvent Dialog box. Bt name Magritudes
|Name :
. . MB: |0
* The latitude and longitude ot Month  Day Me= [0
must be entered as signed 2001 12 |18 ML [o
numbers, negative for west How = Minute  Second oo
g f21 EE {1085 o

longitude and negative for

south latitude. Lattude [M positive]  Longitude [E positive] ok
e x|

Time from event time bo Cancel

Dept [k beainning of record (2]
1] |D Help

d

NOTE: Using internet earthquake databases is described in the next section. Use these
databases to gather the above information about the event.

© University of Arizona 19



Seismology Instruction with the AS-1

Data Identification and Event Location

Searching for Current Events in NEIC (National Earthquake Information Center)

» Launch your browser and go to:
http://wwwneic.cr.usgs.gov

» SeleciNear Real Time Earthquake List

» The 20 most recent events will be displa

Searching for events from the last month:

 Scroll down and click on
Last 30 Days of Earthquake Activity

Searching with NEIC

» Launch your browser and go to
http://wwwneic.cr.usgs.gov

» SeleciEarthquake Search.

FeuskE) A  thtz ety B In |
=
| wBack » = - @[] 4| Qiseach GHFawories BHsory | By op B - 5 |
e =] 2o |[unks »|
National Earthquake Information Center
World Data Center for Seismolegy, Denver
@ The Nisqually Quake - One Year Earthquake Frequency
Later
£ . Descn'ptur!Magniturle | Annual Average
@ Earthquakes Associated with T T
the Eruption of Nyiragongo fregtl Bandiigher L
Major 7-79 18
® Current Earthquake Informati Dy o =
Lurrent Earthquake Information
urrent Earthquake Information T [ e
® Near Real Time Earthquake List Light 4-49 6,200 (estimated)
® General Earthquake Information Minor il 49,000 (estimated)
@ Earthquake Search IMagmtude 2 - 3: about 1,0
y day
@ Source Parameter Search Very Minor| < 3.0 Magginade 1 - 2 about 80|
4 | |
|&] wielcome to the Mational Earthquake Information Center [ [ @ mntermet 7

e Scroll down and sele@lobal Search Area

» Use the default selection for t@eitput File Type

andDatabase

Optional Search Parameters:

Date

| Starting Vear| | Starting Month| | Starting Day

« In theOptional Search Parametersill in a date |' Eoficean]_ ki Mot Traateg Doy
range to narrow down the records. Itis not lighiturle

necessary tolfiin all the fields. NOTE: If you

I Minimum Magnitude Maximum Magnitude

enter a minimum magnitude, the site requires a [P et

value for the maximum magnitude

e Click onSubmit Search

Intensity
i Minimum Intensity Maximum Intensity

Submit Search i Clearform I

Site Output:
When the search is complete, you will see a table of data in your browser window.
Catalogue Day| [Time Depth Magnitude
A 4 ¥ AW P
CAT TELR MO DA ORIG TIMNE LAT LONG  DEP MAGHNITUDE IEFM DT3VHNWE DIST
< A HFPO K
Month Latitude Longitude TFS
PDE-W z001 06 23 203314.13 -16.26 -73.64 33 5.40 MyHRV RGP S R
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Searching the IRIS Earthquake Database

The IRIS event search is very similar to the NEIC event search. However, IRIS also provides a
geographical location in addition to the latitude and longitude.

i m-ia View Favories Took Hep ill
HaBack + = - ) [ A RSewch [aFacites oy | DY O§ ] < o] — |
« Launch your browser and go to S e
http://Awww.iri i — s A
p:/lwww.iris.washington.edu oo s G e gt IR
» Scroll down in the left frameand choose | e —_— -
, B 0 » Dty S
Event Search. RA Mk

Quick Links

» Enter a date range in the search form.
» This site does not require akliils to be
filled in.

* Click onSubmit Search

dat

Iyywymmad]  {hhmmes)

Start F ,_ l_ l‘fi.—.Jlul..'l-H[—:_
End F — I oeptsgomiE [

MR e

Radus [ Latude 50 0
P N
Site Output o :
When the search is complete, you will see a table of data in your browser window.
Mo\n’rh Latitude Depth Magnitude
|\ TIME |LAT |LON DEP MAG TYPE CATALOG REGION
200L/01/26 03:16:40.5000 23 419 70332 | 1680 M3 |[MHDF  [NDIA
[ N x *®_
Day Time Longitude Magnitude Type

Searching for Mining Seismicity
NEIC catalogues routine mining seismicity in the United States.
e Launch your browser and go to: | Jamuary 2001 | February 2001 | March 2001 | April 2001 | May 2001 | Tune 2001 |

http://WWWI‘]eiC_CI’. USgS_gOV | Tuly 2001 | August 2001 | September 2001 | Ottober 2001 | Movember 2001 | December 2001 |
» SelecRoutine U.S. Mining SeismicCity s 200

» Scroll down through the catalogues and click on the month of interest.

Site Output Longitude - -
- Region Magnitude
Date Latitude Depth
CORIGIN TIME \ GEQGRAFHIC DEPTH MAGNITUDE SD GALP NO. F-E REGION, CyNTRIEUTED MAGNITUDES ALND COMMENTS
UTeC COORDINATES G35 S3Th
DALY HE MN SEC LAT LONG my M3 TZED

gL AL OEIEEF 4w el4 . 105532
03 21 07 54.8% 453.7256 N 105.319
04 Z1 21 45.8 36.378 N 110.3543
04 ZZ 00 16.8% 33.213 N 109.=Z62

bl 10 WYOMING, ML 3.3 (G3). 40 miles ENE of Midwest.
246 15 WYOMING. ML 3.5 (GS). 40 miles SSE of Gillette.
176 & EALSTERN ARIZONA. ML Z.4 (G3). 25 miles 350 of Kaventa.
257 & EALITERN ARIZONA. ML 3.4 (G3). 35 miles NE of Safford.

= =55
oOooo
Ly R R
oooo
-1 @ om0

© University of Arizona 21



Seismology Instruction with the AS-1

Filtering

Local and regional event (less than 10 degrees distance) earthquake seismograms are
usually dominated by short period (near 1 s period) energy. Teleseismic (distant earthquakes,
10 to 180 degrees) recordings usually consist of lower frequency (longer period) energy and
often have prominent surface wave arrivals of 12 - 30 s period. The AS-1 seismometer has a
natural period of oscillation of about 1 s. To make the seismometer more useful for recording
distant earthquakes, the long period (greater than 10 s) response of the instrument is enhanced.
Because background noise is always presdiat;ifig of the records is often desirable to
enhance the earthquake signals.

Local and Regional Events

* In the Extract Event Screen, from the File Exteretinll iz K

Cancel

Menu Bar selecBettings > Filter 05

Enter cutaff 2 in Hz Help

|
e

» A useful flter is a bandpasdtir with frequency
cutoffs of 0.5 Hz and 3 Hz (isolating the short
period energy: 2 s -.333 s period).

|

» Enter the two frequencies in thdter Dialog Box.
Global Events
For teleseismic or distant earthquakes, lower frequetenrfg often enhances the

seismogram, especially the surface wave arrivals that are prominent for shallow focal depth
(0 - 70 km) earthquakes.

« In the Extract Event Screen, from the File
Menu Bar selecbettings > Filter Enler cuoff 1 in Hz
I'GE"TI Cancel |
» Suggestedlfer cutoffs for lower frequency E——
Help |

(longer period) signal enhancement are 0.0001 Iﬂi
and 0.1 Hz (isolating the longer period energy:
10,000 s - 10 s period).

» Enter the two frequencies in thdter Dialog Box.
Default Low Pass Filter

* AmasSeis’s default low pasdtér is a display fier that removes high frequency
noise. We recommend that this be set to 3 Hz.
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Additional Resources and Information
AmaSeis Updates
* http://www.geol.bingamton.edu/faculty/jones/as1.html
Identifying Earthquakes or Mining Seismicity
* http://wwwneic.cr.usgs.gov
* http://www.iris.washington.edu
Web Sites for Information and Curriculum Resources
* http://www.eas.purdue.edu/~braile/
* http://www.geo.arizona.edu/geoed/spinet
Time
 http://www.time.gov
* http://www.boulder.nist.gov/timefreg/service/its.htm
Latitude and Longitude
* http://terraserver.nomeadvisor.msn.com
California Earthquake Information

 http://www.scec.org/earthquakes/
(selectRecent California Earthquakeg
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